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1 Introduction  
In this article we will discuss understanding the Solid Edge file format and how to troubleshoot corrupted Solid Edge 

files.  This article will not attempt to determine specific root causes for file corruptions and is only intended as a 

guide to help determine if corrupted files can either be independently repaired or can be forwarded to the Solid 

Edge Development team for potential repair. 

By having a better understanding of the Solid Edge file format and how to work with corrupted files it is hoped this 

knowledge will help reduce time lost with corrupted files – either the file can be quickly identified as corrupted 

beyond repair, or it can be manually repaired, or it may need forwarding to Solid Edge development for further 

analysis and potential repair. 

This document uses examples from previous file repair IRs and PRs to compile a working knowledge of corrupted 

Solid Edge files that can either be repaired manually or forwarded to Solid Edge Development for repair.  As such this 

is intended to be a living document and additional examples of corrupt files will be added as such examples are 

encountered. 

1.1 Caveat 
Although this document will show you how to manually modify the content of the Solid Edge file structure and 

content, Siemens PLM will not support issues with corrupted files where it is evident that manual editing of the 

content of those files has occurred.  Manual editing of the Solid Edge file content through third party tools is an 

unsupported process.  
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2 Background 
Solid Edge files use the Microsoft COM Structured Storage technology as the basis for the Solid Edge file types.   

The purpose of Structured Storage is to provide a solution for storing multiple hierarchical objects that comprise of 

different data types within a single file.  By combining all the related data and objects into a single hierarchical file 

this then reduces the performance penalties and overhead associated with storing separate related data and objects 

in multiple files.  

Essentially Structured Storage allows an “internal file system” to be created within a single file, where the terms 

Storage and Stream correspond to folder/directory and file respectively.  Such files are often called Compound Files, 

although this term is slightly more restrictive. 

The following figure shows a compound file which is a single file that contains a nested hierarchy of storage and 

stream objects, with storage objects analogous to directories/folders, and stream objects analogous to files: 

 

For a brief overview on Microsoft COM Structured Storage, please visit the following Wikipedia site: 

https://en.wikipedia.org/wiki/COM_Structured_Storage 

For more in-depth detail on Microsoft COM Structured Storage, please see the following Microsoft resources: 

https://docs.microsoft.com/en-gb/windows/desktop/Stg/structured-storage-start-page 

 

 

 

 

 

 

  

https://en.wikipedia.org/wiki/COM_Structured_Storage
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3 Viewing the Content of COM Structured Storage Files 
There are many tools available for viewing the content of Microsoft COM Structured Storage files.  Each tool will 

have its pluses and minuses.   

3.1 Structured Storage Viewer 
One such freely available viewing tool is “Structured Storage Viewer”.  Structured Storage Viewer can be download 

from: 

http://www.mitec.cz/ssv.html 

With Structured Storage Viewer installed, you can then run the “SSView.exe” executable to view the content of Solid 

Edge files.  In the following example we have opened the “valve_house.par” file found in the Solid Edge training 

folder (“C:\Program Files\Siemens\Solid Edge 2019\Training\valve_house.par”): 

 

In the above screenshot, we have opened a valid Solid Edge into Structured Storage Viewer and you can clearly see 

the various objects that comprise a Solid Edge file.   

  

http://www.mitec.cz/ssv.html
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Additionally, Structured Storage Viewer will provide a summation of the overall size of the Storage objects within the 

file. 

 

Although Structured Storage Viewer is a very good tool for viewing and modifying the content stored within the 

physical Structured Storage files, Structured Storage Viewer is not a good tool for viewing the content stored at the 

root level of the file or for viewing the CLSID values within the file 
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3.2 Structured Storage eXplorer 
Another freely available viewer is "Structured Storage eXplorer".  Structured Storage eXplorer can be downloaded 

from: 

https://sourceforge.net/projects/openmcdf/files/Sample%20Compound%20File%20Viewer/  

With Structured Storage eXplorer installed, you can then run the “StucturedStorageExplorer.exe” executable to view 

the content of Solid Edge files.  In the following example we have opened the “valve_house.par” file found in the 

Solid Edge training folder (“C:\Program Files\Siemens\Solid Edge 2019\Training\valve_house.par”): 

 

Note that although this is the same file that we opened in the previous section using Structured Storage Viewer, the 

exact same file is displayed differently between the two tools. 

  

https://sourceforge.net/projects/openmcdf/files/Sample%20Compound%20File%20Viewer/
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With this Structured Storage eXplorer tool we are now able to see the content stored at the Root level of the file 

including the CLSID.  This data was not visible in the Structured Storage Viewer tool. 
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However, Structured Storage eXplorer will not provide a summation of the overall size of the Storage objects within 

the file compared to Structured Storage Viewer. 
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3.3 File Archiving Tools 
Instead of using a structured storage viewer, it is also possible to use file archiving tools to view the content of the of 

Microsoft COM Structured Storage files.  One such freely available file archiving tool is 7-Zip. 7-Zip can be 

downloaded from: 

http://www.7-zip.org/ 

With 7-Zip installed, to open and view the content of a Solid Edge file, in Windows Explorer right-click on the .7z file 

and open the file into 7-Zip: 

 

Note: Depending on your operating system configuration, it may not be possible to open Solid Edge files directly in 

to 7-Zip.  In this instance, simply copy or rename the Solid Edge file to the .7z file extension. 

Once opened in 7-Zip, you can see that the objects displayed in 7-Zip are very similar to the objects displayed in 

Structured Storage Viewer for the Solid Edge file: 

 

However, using a file archiving tool such as 7-Zip will only show the storage and streams.  A file archiving tool will still 

show the property set objects but will not display the property values under those property sets.  This is the 

difference between using a structured storage viewing tool and a file archiving tool.  Although it appears that using a 

structured storage viewer would be the better tool, there are times that using a file archiving tool can be beneficial 

to help reinforce what is being observed with a structured storage viewer. 

  

http://www.7-zip.org/
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4 Using Our Structured Storage Knowledge 
Using the above tools, we have demonstrated how to view the structured storage for Solid Edge files.  We can now 

use this knowledge to help investigate corrupted Solid Edge files and determine if the corrupted Solid Edge files are 

suitable candidates for manually repairing ourselves or by forwarding to Solid Edge Development. 

For the remainder of these instructions we will work with the tools outlined above to help investigate various file 

repair examples.  However, you can use other comparable tools and achieve similar results. 
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5 Anatomy of the Structured Storage File 
By having a general base knowledge of the COM structured storage format that comprises a Solid Edge file this then 

can be useful to help determine if corrupted Solid Edge files are potential candidates for file repair. In this section we 

review a brief anatomy of the Solid Edge structured storage. 

There are multiple object types that comprise the structured storage within the Solid Edge file: 

• Root Storage 

• Property Sets 

• Properties 

• Storage 

• Streams  

It is possible to interrogate and view these objects to have a better understanding of the Solid Edge file storage, 

which in turn can then be useful in determining if corrupted Solid Edge files are potentially suitable for file repair. 

5.1 Root Storage 
The top level of the structured storage containing the Property Sets, Properties, Storage, and Streams is called the 

Root storage.   
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5.2 Property Set 
Property Sets are objects used as containers for storing Property objects under.  There are several different Property 

Sets that comprise a Solid Edge file and the Property Sets will differ slightly between the various Solid Edge file types.   

For the valve_house.par used in the previous sections above, when opened in Structured Storage Viewer we see six 

Property Set objects: 
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5.3 Property 
Property objects are stored within the Property Set object and contain the various metadata or property attributes 

associated with the Solid Edge file.  There are many different properties that comprise a Solid Edge file and will vary 

depending on the Solid Edge file type.   

Continuing with our example valve_house.par, we can select the “Summary Information” Property Set and see all 

the Properties stored within this Property Set: 
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Note that in the example used above, there is an Author property with a value of “jmrobins”.  This matches the 

property on the file in Windows Explorer when you select the file and right-click -> Properties: 
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If we interrogate the Property objects of other Property Sets we can see other useful information.  In the below 

example we see the Property Set “{CC024FCA-6EB5-11CE-8AA2-08003601E988}” which contains the various material 

properties used within this Solid Edge file: 
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5.4 Storage 
Storage is an object type used for organizing and collating related Stream object types.  A Storage object for 

structured storage can be thought of as being equivalent to a folder in Windows Explorer.   

In our working example we can see three different Storage objects: 

 

Note there is a “+” symbol next to each of these Storage objects.   
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The + can be selected and expanded to show us the related objects for that Storage object and just like folders in 

Windows Explorer, Storage objects can be nested under other Storage objects.  In our working example we have 

expanded the Display Storage object which then contains another Storage object, “Styles”, which in turn then 

contains various Stream objects: 

 

Depending on the Solid Edge file type there will be many differing Storage types viewable within the structured 

storage.   
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If we open the training files “strainer.asm” (“C:\Program Files\Siemens\Solid Edge 2019\Training\strainer.asm”) and 

“stddb3d.dft” (“C:\Program Files\Siemens\Solid Edge 2019\Training\stddb3d.dft”) and compare them to our 

valve_house.par file we have been interrogating earlier, we can see that there are similar but also different Storage 

objects being used within each Solid Edge file type: 
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5.5 Stream 
Streams are the object types used to contain the physical object data within that makes up a Solid Edge file.  There 

are many different streams that comprise a Solid Edge structured storage file.   

In our working example valve_house.par we can see a Storage object called “PARASOLID”.  This storage object when 

expanded then contains two Parasolid object streams that contain the Parasolid data that comprises the Solid Edge 

geometry: 
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Streams do not have to be stored under Storage objects.  Streams can also exist under the root level of the file: 

 

The Stream object can be interrogated in a structured storage viewing tool.  However, as the Stream object data is 

machine code it will typically only reveal limited information of use to the human reader: 
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5.6 Class Identifier (CLSID) 
Within the Root storage there is an entry called CLSID.  The CLSID key, or Class Identifier, is a string of alphanumeric 

characters that is used globally throughout the Windows operating system to represent a unique value that then 

identifies an object and its application use within Windows. 

In other words, the Root Class Identifier (CLSID) defines what type of file the actual file is and what application it is 

used with in Windows.   

Just because a file has a certain file extension e.g. .asm does not necessarily mean that the file is a Solid Edge 

Assembly file.  The .asm file extension could also be a Pro/E file type.  So, if you try to open a Pro/E file directly in 

Solid Edge how does Solid Edge know that the file is actually not a Solid Edge .asm file?  This is one of the functions 

of the CLSID.  Each structured storage file type should have a unique CLSID, and specifically each Solid Edge file type 

does have its own unique CLSID. 

Opening the valve_house.par file used in our previous examples in to the Structured Storage eXplorer tool we can 

see the CLSID value stored at the Root level: 

 

The above CLSID at the top level of the file indicates that this file is internally identified to the Microsoft COM 

Structured Storage as a Solid Edge part file. 
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We can query the Windows registry using regedit.exe and locate references to this same CLSID value: 

 

Similarly, as we interrogate the content of a Solid Edge file we can also see that there are CLSID values on some of 

the Storage objects.  In the following Solid Edge file there is a Storage object with a different CLSID: 
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If we query the Windows registry for this CLSID value we see the following: 

 

 We can then quickly determine that the application registered to this CLSID is Microsoft Excel: 

 

Therefore, there is an Excel file embedded in to the Solid Edge file. 

  



 
 

 Page 25 of 80  

5.6.1 Solid Edge File Type CLSIDs 
Each Solid Edge file type has a unique CLSID value.  Here is the list of CLSID values for each Solid Edge file type:  

Type File Extension CLSID 

Assembly .asm 00c6bf00-483b-11ce-951a-08003601be52 

Assembly FOA .asm 04d613a0-a322-40b5-a2a4-36ca0de6f5d9 

Assembly Configuration .cfg 00000000-0000-0000-0000-000000000000 

Draft .dft 016b11fb-cdc0-11ce-a035-08003601e53b 

Part * .par 23c52e80-4698-11ce-b307-0800363a1e02 

Part FOP * .par 23c52e80-4698-11ce-b307-0800363a1e02 

Sheet Metal  .psm dd8522e0-2375-11d0-ac05-080036fd1802 

Weldment .pwd 98ccdf9c-213b-11d4-b64c-00c04f79b2bf 

Packaged Collaboration File  .pcf 64e909e5-4acc-496c-8e4b-a660dc6a56ec 

 

* Note: The Part and Part FOP files contain the same CLSID value.  
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6 Potential Causes of Solid Edge File Corruption 
In the following section we will attempt to identify some potential causes for file corruption.  Once a file has become 

corrupted it is not possible to then identify how that file became corrupted.  To avoid any future file corruptions will 

require some investigative analysis on the part of the customer with some potential underlying architecture and/or 

operating system and/or application changes being required. 

The following list of potential causes are not listed in any order of frequency or likelihood of occurrence.  Nor will 

avoiding only one of these potential causes necessarily resolve any ongoing file corruptions in the customer 

environment.  It may take a combination of avoiding multiple potential root causes to resolve all file corruption 

scenarios in the customer environment. 

• Network Stability 

• Thumbnail Caching  

• Anti-Virus 

• Disk Write Caching 

o Removable Disk Drives 

o Distributed File System 

• Cloud File Syncing 

• Disk Compression  

• Mapped Drives  

• Downstream Usage of Files  

• Custom File Save Events 

• Family of Assembly Files  
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6.1 Network Stability 
If Solid Edge files are stored on a file server and are accessed by the client across a network, then network stability 

can be a potential cause for file corruption, especially if the network drops during the process of saving a file. 

Note: It is beyond the scope of GTAC to provide support and advice regarding network configuration and 

investigation of any network related issues. 

Network save issues may be captured within the Solid Edge file under a separate Stream object.  For PR# 9403648, 

which was submitted for a corrupt assembly file, if we open the assembly file from this PR in our Structured Storage 

viewing tool we can observe the following “NetworkError” Stream object:  

 

If we view the content of this stream object in the “As Text” tab of the viewer tool, we can clearly see the timestamp 

of when a network error was recorded in the Solid Edge file.  In this instance, 05/06/2018 at 13:59:13: 

 

Although this “NetworkError” object exists and tells us when a network issue was detected and recorded, this does 

not provide any indication as to a root cause for the network stability issues.  This object simply indicates that there 

have been some network stability issues at the customer site at the time this error was recorded.  However, if the 

customer is reporting many corrupted files and the majority of corrupted files have this “NetworkError” object then 

this is an indicator that there has been network stability within the customer environment. 
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If network stability during file saving is suspected as a potential cause of file corruption you can enable in the registry 

the following debug switch: 

HKEY_CURRENT_USER\Software\Siemens\Solid Edge\Version 219\DEBUG\LOG_SAVEFAILURES_TO_FILE = 1  

 

With this switch enabled, any save failures should be captured in the %APPDATA%\Siemens\Solid Edge\Version 

xxx\SaveFailurelog.txt file and this log file can be reviewed to confirm any network disconnects that may be 

occurring. 
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6.2 Thumbnail Caching  
In Windows Explorer by default the caching of thumbnails of files on network shares is enabled by default.  This 

caching of thumbnails can cause the files to still be considered open by the underlying operating system thereby 

preventing successful completion of writing of the internal storage objects to the file.  This was an issue in an earlier 

version of Solid Edge.   

This should now be resolved in newer Solid Edge versions but should still always be considered as a potential source 

for future corruption.  For more on disabling thumbnail caching see the following Solution Center article: 

http://solutions.industrysoftware.automation.siemens.com/view.php?si=002-7004168 

For more information on Windows thumbnail caching: 

https://en.wikipedia.org/wiki/Windows_thumbnail_cache 

 

  

http://solutions.industrysoftware.automation.siemens.com/view.php?si=002-7004168
https://en.wikipedia.org/wiki/Windows_thumbnail_cache
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6.3 Anti-Virus 
Anti-virus scanning can lock a Solid Edge file during the save operation such that Solid Edge then cannot complete 

the save of all the internal storage objects. 

Therefore, the best practice is to configure anti-virus software to exclude Solid Edge file types. 

Remember to configure both the server and the clients for the exclusions.  It makes no sense to configure the clients 

with anti-virus exclusions to then still have anti-virus scanning Solid Edge files on the server. 

There are several Solution Center articles available that document best practices for configuring anti-virus for use 

with Solid Edge: 

http://solutions.industrysoftware.automation.siemens.com/view.php?si=002-8007557  

http://solutions.industrysoftware.automation.siemens.com/view.php?si=002-8007556  

  

http://solutions.industrysoftware.automation.siemens.com/view.php?si=002-8007557
http://solutions.industrysoftware.automation.siemens.com/view.php?si=002-8007556
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6.4 Disk Write Caching 
Disk write caching is an operating system feature that improves system performance by using fast volatile memory 

(RAM) to collect write commands sent to data storage devices and cache those write commands until the slower 

storage device e.g. hard disk can be written to later. This allows applications to run faster by allowing the application 

to proceed without waiting for data write-requests to be written to the disk. 

While disk write caching may increase both system and application performance, it can also increase the chances of 

data loss in case of power or system failures before the data from the write-cache buffer is flushed by successfully 

writing the data to the disk: 

 

Disk write caching can introduce file corruption if a file is frequently saved and the data stored in RAM is being 

overwritten before the data has been fully written to disk. 

Disk writing caching should always be used with care.  The general recommendation to ensure Solid Edge file 

stability should be to avoid disk caching where appropriate. 
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6.4.1 Removable Disk Drives 
Removable USB drives use disk writing caching to improve performance.  However, if disk write caching is enabled 

then the user must run the operating system “Eject media” command to ensure that the data in RAM is written to 

the disk before the media is removed.  

 

 

If a USB drive with disk write caching is removed before the data in RAM is finished writing to the disk, this then can 

cause file corruption.  
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6.4.2 Distributed File System 
A distributed file system (DFS) is a file system with data stored on one or more servers. The data is accessed and 

processed as if it was stored on the local client machine. The DFS makes it convenient to share information and files 

among users on a network in a controlled and authorized way. The server allows the client users to share files and 

store data just like they are storing the information locally. However, the servers have full control over the data and 

give access control to the clients.  

Depending on how the DFS has been configured, it is possible to save a Solid Edge file multiple times and have the 

data in server RAM changed before the initial data has been fully saved to all server locations.  This can then place 

the Solid Edge file into an inconsistent state resulting in Solid Edge file corruption. 

The Solid Edge readme file explicitly states we have not tested Solid Edge with DFS environments and that any issues 

with Solid Edge in a DFS environment will not be addressed: 

 

For more on the Microsoft Distributed File System:  

https://docs.microsoft.com/en-gb/windows/desktop/Stg/structured-storage-start-page 

 

  

https://docs.microsoft.com/en-gb/windows/desktop/Stg/structured-storage-start-page
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6.5 Cloud File Syncing 
Cloud file syncing is an application that keeps files in different locations up to date through the cloud. For cloud file 

syncing, a user sets up a cloud-based folder, to which the desired files are copied. This folder makes the files 

accessible via an interface for multiple users, on whatever device they are using. When a user updates a file, the 

changes are automatically synchronized with the corresponding folders on other user devices.  

Depending on the cloud storage solution implemented, typically after a file is initially synced to the cloud, further 

modifications to the file does not result in the entire file being resynced to the cloud but instead only chunks of data 

based on the changes to the underlying physical file content are synced back into the cloud.  This file syncing method 

is used for performance with the cloud syncing, especially in a multi-user syncing environment.  However, for larger 

file formats, such as Solid Edge files, and with more frequent saves it is possible for these chunks of modified file 

data to collide resulting in conflicts with the data ultimately resulting in a corrupted file. 

Solid Edge does provide support for cloud file syncing services.  However, it is important to ensure that the “Enable 

distributed file access when using file replication services” within the Solid Edge Options is enabled. 
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6.6 Disk Compression  
Disk compression is a type of data compression that works by storing compressed versions of files on the hard disk. A 

disk compression utility sits between the operating system and the disk drive. Whenever the operating system 

attempts to save a file to disk, the utility intercepts it and compresses it. Likewise, when the operating system 

attempts to open a file, the disk compression utility intercepts the file, decompresses it, and then passes it to the 

operating system. Because all applications access files through the operating system, disk compression utilities work 

with all applications. The entire process is transparent to the user, though opening and closing files may take a little 

longer. On the other hand, a disk compression utility can double the amount of disk space available.  

Because disk compression requires an intermediate software layer to successfully write the file to disk, this in of 

itself introduces another element of potential failure and corruption in to the system.  Additionally, when working 

with larger file formats and more frequent saves it is possible for the compression layer to become overwhelmed 

resulting in collision and conflicts with the data, ultimately resulting in a corrupted file. 

Although disk compression will increase available hard drive space it is advisable to disable any disk compression for 

file stability.  Disk compression can be in place on either the client or server or both: 

 

For more information on disk compression: 

https://en.wikipedia.org/wiki/Disk_compression 

 

 

  

https://en.wikipedia.org/wiki/Disk_compression


 
 

 Page 36 of 80  

6.7 Mapped Drives  
Windows mapped drives represent shared drives on a file server with those resources being mapped to the client as 

internal Windows drive letters such that the shared resource appears local to the client. This method offers users an 

easier way to connect to shared drives because the client operating system will remember the mapping and load it 

for the user.  

Windows mapped drives technology dates back to Windows 3.1.  There are certain known inherent issues with using 

mapped drives, including mapped drive timeouts and disconnects.  These automatic timeouts and disconnects then 

require the underlying operating system to automatically reconnect the mapped drive.  This delay in automatically 

reconnecting a disconnected mapped drive can cause unreliability and stability issues.  Because of these inherent 

issues with mapped drives in the Windows operating system, Microsoft later introduced Universal Naming 

Convention (UNC) as a replacement to mapped drives. 

Under the hood, Solid Edge attempts to uses UNC conventions in place of mapped drive letters.  Because of the 

unreliability of mapped drives, the recommendation is that mapped drive letters should be avoided.  Instead the 

customer should always be accessing network data through UNC paths and using Network Folder shortcuts in place 

of mapped drive letters. 
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6.8 Downstream Usage of Files  
Many customers will implement their own unique and custom downstream processes on their Solid Edge files.  Some 

examples of downstream processes include providing file viewing capabilities to the shop floor, automatically 

generating PDF and other file formats, automated release processes, et. al.  These downstream processes require 

accessing the Solid Edge files.  Depending on how the downstream process are implemented there is potential for 

these downstream processes to lock the Solid Edge files thereby preventing access and or potentially corrupting the 

files.   

Part of investigating possible root causes for consistent file corruptions should take in to consideration any 

downstream process that are implemented.  If downstream processing of the file is in place, depending on the 

analysis of what this downstream processing is doing, then this downstream processing may need to be temporarily 

paused if no other root cause for file corruptions can be determined. 
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6.9 Custom File Save Events  
Some customers will write their own custom Save events in order to provide either pre- or post- save processing to 

the file after it is saved to disk.  A custom Save event will replace the out-of-the-box Save event.  Depending on what 

the custom Save event is attempting to accomplish, and how the custom code has been written, it is possible to that 

the file could become corrupted because of this pre- and/or post- processing on the file.  

Part of investigating potential root causes for consistent file corruptions should take in to consideration any custom 

Save event implemented.  It may be necessary to temporarily pause using a custom Save event if no other root cause 

for file corruptions can be determined. 
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6.10 Family of Assembly Files 
If you are experiencing frequent corruption of Family of Assembly (FOA) files, it may be necessary to implement the 

earlier ST5 save method to help prevent and or reduce FOA file corruptions. 

In the user’s registry enable the following debug switch: 

HKEY_CURRENT_USER\Software\Siemens\Solid Edge\Version XXX\DEBUG\UseST5SaveBehaviorforFOA = 1 
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7 Troubleshooting Examples 
In the following section we will review various corrupted Solid Edge files and investigate if those corrupted Solid 

Edge files can potentially be repaired by development. 

NOTE: The following examples are intended to be guides to help you quickly determine if a corrupted Solid Edge file 

can potentially be repaired or not.  If, at any time when investigating a corrupted Solid Edge file, you are unsure if 

the file can be repaired or not, assume the file can be repaired and forward on to Development as a PR for file repair. 

7.1 Not Compatible with the Solid Edge Product  
Reference: IR# 8409865 

In Solid Edge when attempting to open the file we receive the message “The file you are attempting to open is not 

compatible with the Solid Edge product you are using.  It was possibly saved with an Academic License or a newer 

version of Solid Edge. Contact your customer support provider for additional information.”: 

 

This error message appears to be self-evident.   

Try opening the file using an educational license.   

If the file will open using an educational license and/or a newer version of Solid Edge, then this is the cause of the file 

not opening. 

If the file does successfully open with an educational license the file should not be submitted to Development for 

repair.  Instead the customer should obtain a free educational license, open the file using that educational license, 

and attempt to capture, export, and save whatever they can from the file for recreation into a commercially licensed 

version of Solid Edge. 
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7.2 Stuck in Sketch Environment   
Reference: IR# 9411071 

When opening the file in Solid Edge, the file is immediately opened in to the Sketch environment and selecting 

“Close Sketch” has no impact – the file is permanently “stuck” in the Sketch environment: 

 

To resolve this issue, on the tab for the file, right-click -> New Window: 

 

In the new window that is opened, the file is no longer opened in the Sketch environment: 
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Right-click on the original tab which is still stuck in the Sketch environment and select “Close Window”: 

 

Save and close the file. 

The file has now been successfully repaired and is no longer stuck in the Sketch environment. 

 

 

  



 
 

 Page 43 of 80  

7.3 Filename Display on Tab and Title Bar Are Incorrect  
Reference: IR# 9260629 

In Windows Explorer the file is named on disk as “10000645927ses000.psm”: 

 

However, when opening the file in Solid Edge, both the file tab and the title bar display the filename as 

“1000079554ses000.psm Normal Cutout”: 

 

To resolve this issue, on the tab for the file, right-click -> New Window: 
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In the new window that is opened the file tab and title bar now display the correct filename: 

 

Right-click on the original tab which still displays the incorrect filename and select “Close Window”: 

 

Save and close the file. 

The file has now been successfully repaired and the incorrect filename is no longer displayed on the tab and title bar. 
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7.4 No Translator Is Available for This File Type 
Reference: IR# 8324598 

In Solid Edge when attempting to open the file we get the following message: 

 

If we look at the file in Windows Explorer, we can see that there is no size to the file – the file is 0 KB in size.   

 

If the file is 0 KB, then there are no objects stored within the file thereby making the file empty of any content.  If 

there is no content, then there is no data that can be recovered.  At this point there is no need for any further 

analysis.  However, for the purposes of this document we will continue with further analysis using our tools. 

Opening the file in Structured Storage Viewer we see the following: 
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Open the .7z file in 7-Zip we see the following: 

 

These messages confirm that there is no valid structured storage with the file to be opened and read.   

If there is no valid structured storage that can be read by the various tools, then the file cannot be repaired.   

This file does not need to be forwarded as a PR to development for further investigation. 
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7.5 No Translator Is Available for This File Type  
Reference: PR# 8898643 

Opening an assembly file, the error message “Cannot open xxxx.asm.  No translator is available for this file type.“ is 

thrown and the part will not open: 

 

Opening the assembly file in to one of the structured storage tools we can see that the content of the file is actually 

an assembly configuration .cfg file that has been incorrectly renamed to the .asm file extension: 

 

This is not an assembly file that can be repaired per se.  Simply renaming the file extension from .asm to .cfg will 

allow the configuration file to be reused in Solid Edge. 
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7.6 Error xxxxxxxx – Cannot Open File 
Reference: IR# 9316127 

Opening the draft file in Solid Edge will throw an error message dialog with a consistently changing error code: 

 

Opening the file into our toolset, and interrogating the various stream objects show that most of the stream objects 

have size and content, but that content is all zeros: 
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Because so many streams have zeros written over their content, this file cannot be repaired. 

7.7 No Error Messages 
Reference: PR# 8918403 

The assembly file will not open in Solid Edge and Solid Edge does not give any feedback or error message.  The file 

simply does not open. 

If you create a copy of the file renamed to the .7z file extension and attempt to open the file in 7-Zip you will notice 

that there does not appear to be any objects contained within the structured storage: 
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If you open the file in Structured Storage Viewer, you will again the notice the lack of any objects contained within 

the structured storage: 

 

Because there are absolutely no objects continued within the structured storage, this file cannot be repaired. 
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7.8 No Error Messages 
Reference: PR# 7630674 

The assembly file will not open in Solid Edge and Solid Edge does not give any feedback or error message.  The file 

simply does not open.  Although this behaviour is the same as the previous example, the content of the underlying 

structed storage is significantly different so warrants different analysis.  

If you create a copy of the file renamed to the .7z file extension and attempt to open the file in 7-Zip you see the 

following: 

 

If you open the file in Structured Storage Viewer, unlike 7-Zip, the file will successfully open: 
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However, further interrogation of the various Storage objects shows that many of the Storage objects e.g. JSitexxx, 

Dipslay, PSMspacemap, IOT, etc. have zero size:  
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These zero-size storage objects are unexpected and is preventing the file from being successfully opened in Solid 

Edge.   

Primarily, because so many of the streams have zero size and secondly, because the file cannot be opened in 7-Zip, it 

is assured that this file will not be able to be repaired.  Once submitted, Development was unable to repair this file 

because of so many of the file streams having zero size. 
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7.9 File Was Created with A Pre-Release Version of Software - Draft 
Reference: PR# 1929296 

When opening the draft file, we get the error “This file was created with a pre-release version of software. The file is 

no longer valid.” and the file is not opened:  

 

If we attempt to open the file into 7-Zip, we can confirm that the file will successfully open: 
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The file will also successfully open into Structured Storage Viewer: 

 

With the file open in Structured Storage Viewer we can then start investigating the various Stream objects. If we 

interrogate the streams under the PSMspacemap Storage object we can clearly see that these streams have content 

but that the content contains all zeros:  
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Something has written zeros of a portion of the file.  This file cannot be repaired. 
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7.10 File Was Created with A Pre-Release Version of Software - Part 
Reference: PR# 9045019  

Attempting to open the part file provided under we receive the message “This file was created with a pre-release 

version of software. The file is no longer valid.” and the file is not opened in Solid Edge: 

 

Opening this file in one of our structured storage tools, we can then expand and view the content of the Parasolid 

Storage object: 

 

We can then view the content of the underlying Stream objects.  For the STREAM0.D_B stream we can see that there 

is content, but that content contains nothing but zeros: 
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We can also see that the STREAM0.P_B stream also contains nothing but zeros: 

 

 

As there is no actual Parasolid content contained within this file, there is no model geometry that can be either 

repaired or recovered from this file. 

This file is unrecoverable and cannot be repaired. 
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7.11 Server Busy  
Reference: PR# 9143188 

The customer is trying to open a draft file.  However, the draft file does not successfully open.  Eventually Solid Edge 

will throw a “Server Busy” message: 

 

Further, in Task Manager we can see that Excel is being launched from Solid Edge when opening the file: 

 

At this point the file never opens and Solid Edge and Excel need to terminated in Task Manager. 

As this issue appears to be related to trying to open Excel linked data within the Draft file we can potentially resolve 

this using our toolsets. 
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Open the draft file into one of our structured storage tools e.g. Structured Storage Viewer and expand the objects.  

Note all the JSite storage objects: 
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Expand the first JSite storage object: 

 

Under this storage we have several PropertySet and Stream objects.  If we start interrogating these objects we can 

see that this storage object appears to be an embedded Excel file: 
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Additionally, this appears to be an Excel 2003 file: 

 

It appears that the user has embedded an Excel file into the draft file. 

Right click over the JSIte storage object that contains our Excel file data and select Delete: 

 

The objects containing the embedded Excel file have now been removed. 

  



 
 

 Page 63 of 80  

Continue interrogating the JSite storage objects and delete any remaining objects that containing Excel files in them: 

 

Save the modified file.  

Now the repaired file will open into Solid Edge without issue. 
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7.12 Make Sure the File Is the Correct Type and Version for The Application – Draft 
Reference: IR# 9391889 

Opening a draft file throws the error message “Cannot open file.  Make sure the file is the correct type and version 

for the application and that you have read access.” and the file is not opened: 

 

If we open the file in to one of the structured storage tools we can see that there are several PropertySet and Stream 

objects related to file properties: 
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However, we can also see that there are no Storage objects.  This is unexpected, as a valid Solid Edge file should have 

several Storage objects within its content as shown in the following valid draft file: 

 

This corrupted file cannot be repaired as there is no draft related data other than property information available to 

recover. 
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7.13 Make Sure the File Is the Correct Type and Version for The Application – Part 
Reference: IR# 9417777 

Opening a part file throws the error message “Cannot open file.  Make sure the file is the correct type and version 

for the application and that you have read access.” and the file is not opened: 

 

If we open the file in to one of the structured storage tools we can see that there are two objects within the file 

structure: 

 

This is unexpected, as a valid Solid Edge file should have many different objects within its content as shown in the 

following valid part file: 

 

This corrupted file cannot be repaired as there is no part related data available to recover.  
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7.14 Make Sure the File Is the Correct Type and Version for The Application – FOA  
Reference: IR# 9312193 

Opening a Family of Assemblies (FOA) assembly file from Windows Explorer throws the error “Cannot open file.  

Make sure the file is the correct type and version for the application and that you have read access” and the file is 

not opened: 

 

Opening the FOA from within Solid Edge will allow the file to successfully open and the “Assembly Member” dialog 

will be displayed: 

 

However, after opening, it is then not possible to select and change the FOA members: 

 

This would appear to indicate the FOA file is not correctly identified or tagged as an FOA file. 
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Open the file in to the “Structured Storage eXplorer” tool so we can review the CLSID value for this FOA file at the 

Root level: 

 

We can see that the current CLSID value for this file is currently “00c6bf00-483b-11ce-951a-08003601be52”.  

However, if we quickly review the earlier section in this document on CLSID values we know that an FOA file should 

have a correct CLSID value of “04d613a0-a322-40b5-a2a4-36ca0de6f5d9”. 

Double-click into the CLSID field and change its value to “04d613a0-a322-40b5-a2a4-36ca0de6f5d9”.  You can copy 

and paste the value: 
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Then select File -> Save to save our modifications. 

The CLSID tag has now been corrected and the file repaired.  The file should now open and work as expected within 

Solid Edge without any further issue. 
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7.15 Model File Is Not Saved in The Current Version. Drawing Views Cannot Be Created or Updated. 
Reference: IR# 9417777 

Opening a draft file throws the error message ”The model file is not saved in the current version. Drawing views 

cannot be created or updated. If dimensions are placed in the current state of the drawing and the model changes 

before the link is resolved, these dimensions may be deleted on update.”.  However, the file is successfully opened: 

 

Select Tools -> Assistants -> Drawing View Tracker: 

 

In the Drawing View Tracker we can see that a part within one of the sub-assemblies has changed: 
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If we attempt to open this changed part file in Solid Edge, we then receive the following error message for the child 

part: 

 

We have already addressed how to interrogate and potentially fix this type of “make sure the file is the correct type 

and version” error for the part file in an earlier troubleshooting example.  It is not necessary to review this corrupted 

child part file to continue resolving the issue being addressed within this section for the error message when opening 

the draft file. 

We need to remove this corrupted child part file from the assembly structure.  In this example we simply rename the 

corrupted file on disk in Windows Explorer: 

 

 

Then when you reopen the draft file, the draft will open without issue and without any error messages.  Because we 

have removed a child from the assembly structure, as expected, the Drawing Views are marked as out of date: 

 

However, at this point the original issue with the draft file is now resolved and we can continue to work with the 

draft as needed.  You will still need to address the underlying root cause for the original error message which is the 

now identified corrupted child part file. 
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7.16 Part with Non-Existent Link to Assembly  
Reference: PR# 9271478 

Note this issue is similar to the upcoming next example shown below.  This example provides a more complex 

solution to show how to manually locate and remove links using the structured storage toolsets.  The next upcoming 

example will provide a much simpler solution that will also work for this example. 

The part file appears to have a reverse link to an assembly: 

 

Opening the assembly, we see there are no links to the part: 

 

Open the part and there are no links to the assembly: 
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Additionally, open the part file in to Design Manager and the icon appears to indicate there is a linked file: 

 

Apparently, there is a non-existent link in the part to the assembly. 

Open the part file into a Structured Storage eXplorer and begin interrogating the storage structure.  Expand the 

JReverseLinks storage object: 
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JReverseLinks storage is where the reverse links in Solid Edge are maintained.  Under this storage object is another 

storage object JReverseSiteInfoxxxx: 

 

If we then expand this JReverseSiteInfo storage we see two streams: 

 

If we interrogate the content of these streams we can see that there is a link defined back to the assembly file: 
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Select the higher level JReverseSiteInfo storage object containing these streams and right-click -> Remove to delete 

the Solid Edge link data: 

 

Save the modified file. 

Now the part file will open in Solid Edge without prompting that there is a link to the assembly.  This can also be 

further confirmed in Design Manager as the icon no longer shows a link: 
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7.17 Ghost Link in Part to Assembly 
Reference: PR# 9272264 

Note this example is similar to the previous example shown above.  This simpler solution is provided here for 

reference, with the more complex solution shown above provided to show how to manually locate and remove links 

with the structured storage toolsets. 

Open the part file in Design Manger and right-click -> “Show Parents”.  There is a link shown to a parent assembly: 

 

Open the part file in Solid Edge and there are no links to the assembly shown: 

 

In the Inter-Part Links dialog right-click on the part name and select “Break Links”: 

 

Close the dialog and save the file.  The link to the parent assembly is now removed and the part file has been 

repaired.  
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8 Submitting Files for Potential Repair 
If after following the troubleshooting examples above, you are able to successfully open and read the content of the 

Solid Edge file in to the various third-party tools, the corrupted file structured storage is not similar to any the above 

examples shown, and you cannot manually repair the file yourself, then it may be possible to have the Solid Edge 

Development team repair the file.   

8.1 Customer Submitting IR to GTAC For File Repair 
For customers submitting files for repair to GTAC it would be beneficial to complete the following survey to help try 

to identify a potential root cause for the file corruption.  Submit the results of this survey as part of the file repair IR.   

1. Do you use a data management system?  If so, which one?    

2. If you do not use a data management system, do you save files directly to a remote machine on the 

network or to cloud storage?   

3. Do you use any automation programs or add-ins that are triggered on Solid Edge save events?  If so, what 

are they?   

4. Is Automatic Document Preservation enabled on the Solid Edge Options -> Save tab?  

5. Solid Edge allows users to save files after a crash has occurred.  Was the last save made after a crash?   

6. Has the file been saved to a USB drive or thumb drive prior to the failure to open?  

7. What anti-virus software are you running? What exclusions, if any, have you made to the anti-virus for 

Solid Edge?  

8. Were these files created and saved using the same version of Solid Edge that you are attempting to open 

them with? If not, what version were the files created in and what version were the files last saved in?  

9. Is there anything you can add that may provide clues to the cause of the corruption? 
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8.2 GTAC Submitting PR to Development for File Repair 
For GTAC engineers when submitting a PR to Development for potential repair, please follow the process as 

documented in the following internal Solution Center article: 

http://gtac.industrysoftware.automation.siemens.com/view.php?si=002-8008358 

After submitting a PR to Development, it may also be beneficial to review with the customer the list of Potential 

Causes of Solid Edge File Corruption section presented earlier in this document.  To briefly reiterate those potential 

causes: 

• Network Stability 

• Thumbnail Caching  

• Anti-Virus 

• Disk Write Caching 

o Removable Disk Drives 

o Distributed File System 

• Cloud File Syncing 

• Disk Compression  

• Mapped Drives  

• Downstream Usage of Files  

• Custom File Save Events 

• Family of Assembly Files  

  

http://gtac.industrysoftware.automation.siemens.com/view.php?si=002-8008358
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9 Summary 
By developing an understanding of how Solid Edge files are constructed and how to read the content of the Solid 

Edge files, we are now able to better determine the suitability of a corrupted file and the likelihood of success for a 

repair, including manual repairing for ourselves or by submitting to Solid Edge Development as a PR for file repair. 

 

David C. Merritt 
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10 Revision History 
Version Date Change 

1.0 14-Mar-2019 Initial release 

2.0 02-Apr-2019 Added “Revision History” section 

  Added “NetworkError” stream to “Network Stability” section 

  Added “Stuck in Sketch Environment” example to “Troubleshooting Examples” section 

  Added “Filename Display on Tab and Title Bar Are Incorrect” example to 
“Troubleshooting Examples” section 

  Added “Make Sure the File Is the Correct Type and Version for The Application - Part” 
example to “Troubleshooting Examples” section 

  Added “Model File Is Not Saved in The Current Version. Drawing Views Cannot Be 
Created or Updated” example to “Troubleshooting Examples” section 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

 


